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RSNA Digital Presentation System (DPS) Editor – 2021 

 
 
Your presentation must be saved as a single .pptx file with all supporting media files embedded.  
Supplemental file uploads are no longer supported. In PowerPoint, use Optimize Compatibility to embed your 
supporting media files. (See section 4 for more information.) 
 
GETTING STARTED 
It is important to review these guidelines to assist you in preparing your presentation.  The digital presentation 
submission process will convert your presentation created in PowerPoint for Office 365, PowerPoint for 
Windows (2010 or above), PowerPoint for Mac, Keynote, or Google Slides to a mobile-friendly format that will 
work on tablets, mini tablets, smart phones, and laptops with up to date standards-based, HTML5 compliant 
browser. Keep the following in mind: 
 

Password-protected files will halt the conversion process for your file and any others that are in the 
queue behind yours.  If your pptx file is currently password-protected, please be sure to remove a 
password requirement for the file you plan to upload to the DPS system. 
 
Powerpoint for Mac, Keynote, and Google Slides: If you create your presentation in one of these 
softwares, you will have to save it in .pptx format.  Please be aware that your presentation may not look 
the same when opened in PowerPoint for Windows. Please remember to preview your .pptx 
presentation in the latest version of PowerPoint for Windows and correct any errors before uploading. 

   
Expectations:  Presentations should reflect the content contained in the accepted abstract.  
Presentations should be created so the attendee can view a presentation in its entirety in under 10 
minutes, as most attendees spend between 2-5 minutes viewing an electronic presentation.  Your 
presentation must be non-promotional and non-commercial in nature. Refer to all products and 
equipment by their generic identification.  

 
Intellectual Property Statement:  Your presentation must consist of original work with no previously 
copyrighted material including media/cartoon content. Reported misuse of intellectual property 
persists. Including borrowed materials (text, images, graphs, charts, etc.) in your presentation may fall 
within 'fair use' for educational purposes. However, such materials should never be presented as if they 
are your own. You must assure that sources of borrowed material are clearly labeled in your RSNA 
presentation, including full citations for any copyrighted material. It is also best practice to inform 
and/or seek the permission of the original creator of non-copyrighted content before using it in your 
RSNA presentation. When content seems to lack proper attribution, you may be asked by the RSNA to 
provide an explanation for including the material without proper acknowledgement in your 
presentation. 
 
PHI. In all instances patient confidentiality must be protected. No patient names, hospital ID numbers or 
any other information that allows the patient to be identified should appear in images or illustrations.  
Please visit the Presenter Site (abstract.rsna.org) for further details and appropriate forms, under the 
‘Important Information’ section.  
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1. 2021 Deadlines:  
All deadlines are at 12:00 Noon, Central (Chicago) Time 

• Education Exhibits   Wednesday, October 20 
• Quality Improvement Reports  Wednesday, October 20 
• Scientific Posters   Wednesday, October 27 
• Case of the Day    Wednesday, October 27 

 
 
2. System Requirements  
In order to use this system, your browser must have Cookies and JavaScript enabled. We support the following 
web browsers:  
 

• Google Chrome (recommended) 
• Mozilla Firefox  
• Apple Safari   
• Microsoft Edge  

 
Note: Depending on your security settings you may need to add *.rsna.org in your trusted sites list.  
 
In addition, some actions, such as large file uploads, may be blocked by your institution's firewall. Check with 
your IT staff if you are having difficulties uploading files or cannot adjust your security settings.  
 
 
3. Animation Click Limit (Education Exhibits only) and Slide Allowance  
Each type of DPS presentation has a slide limit. Your PowerPoint file must contain no more than the maximum 
number of slides allowed.  The conversion process will be halted for any presentation that contains slides in 
excess of the slide limit for the program area, according to the chart below. 
 

Type of Digital Presentation (Program Area) Slide Limit Click Limit 
Education Exhibits (slide show) 35 75 clicks 
Quality Improvement Reports 10 N/A 
Science Posters 40 N/A 
Case of the Day History (1st Day) 1 N/A 
Case of the Day Discussion (2nd Day) 35 N/A 

 
Please limit use of text animations. User feedback surveys show that users prefer not to click through each bullet 
point on a slide. PowerPoint tip: to manage animations, click on the Animations tab, then Animation Pane. 
 
For Education Exhibit presentations only:  There is a limit of 75 clicks, including transition to the next slide, 
regardless of the number of slides in your presentation 
 
 
4. General RSNA Presentation Guidelines: Before You Begin the Submission Process 
Prepare your presentation material on your local drive. Your final presentation should consist of a single .pptx 
file. Microsoft PowerPoint for Windows (2010 or above) is the preferred presentation software. PowerPoint for 
Office 365, PowerPoint for Mac, Keynote, Google Slides, or similar presentation software that allow the finished 
file to be saved as .pptx format are also supported. Supporting media must be embedded into your final 
presentation file. In PowerPoint, use Optimize Compatibility to embed your video/audio files. 
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A. Supported File Formats 
• Presentation:  .pptx 
• Video (must be embedded into .pptx): *.mp4, *.avi; *.mov; *.mpeg; *.gif 
• Audio (must be embedded into .pptx): *.mp3; *.wav. 

 
B. Video 

DPS supports video embedded within your presentation, however you must follow these important 
guidelines. 

 
1. Cropped video.  In order for cropped videos to display properly in your RSNA 2021 digital 

presentation, you must clip the video to remove any patient information or unwanted sections of 
the video, in video editor software before inserting it into your PowerPoint file.   
 

2. Video Controls. All videos will be set to auto play and loop.  A set of controls will appear over the 
video when an attendee places their mouse over the video. Attendees can pause, play, and scroll 
through the video. Some mobile devices do not support video auto play due to data plan settings 
and the attendee will need to hit the play button.  

 
3. Embedded Video As a result of no longer supporting older versions of PowerPoint video files can no 

longer be uploaded separately from your PowerPoint presentation.  Please be sure you are using 
PowerPoint 2010 or above and set your videos to be embedded within the PowerPoint using the 
Optimize Media Compatibility feature.  Click on File, then Info; then select Optimize Media 
Compatibility.  Let the process run. When it has completed, click on Close. Save your file. Note:  If 
the Optimize Media Compatibility option does NOT display, your media is already optimized. 

 
C. Sound/Audio Recommendations: RSNA does not recommend the use of sound in the DPS format. 

Should you decide to incorporate sound into your presentation, we recommend that you clearly indicate 
this with a statement or graphic on the first slide of your presentation, and on any subsequent slide 
where sound is featured.  

   
 
5. Using the Presentation Editor: Three Easy Steps 
To submit your presentation, please click the ‘DPS Upload’ link at the top of your main portal page. From there, 
you will see the title of your presentation(s) listed. Select your presentation title and you will be directed to the 
Presentation Editor screen. On the Presentation Editor, click on the EDIT icon for the presentation you will be 
submitting. 
 
On the next screen, verify your email address.  If you change the default email address shown on the screen, it 
will only be used to receive system-generated notifications indicating that the file conversion is complete, or 
that a video file(s) is needed.  
 
The submission process has been simplified into three easy steps. 
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Step 1: Convert File 
Click on Add Files to Queue to browse your computer and select the PowerPoint file. Follow the prompts to start 
the conversion process. You may need to manually initiate the conversion process by clicking the button labeled 
Step 1: Click to Convert files.  

 
a. Conversion times:  Depending on how many videos and animations you have in the presentation, the 

conversion process may take from 5 to 30 minutes. During peak times beginning 72 hours prior to 
posted deadlines, conversion times may be longer. Please plan accordingly. As a reminder, your 
presentation will be converted to a mobile-friendly format.  

 
b. System Messages:   Two types of system-generated error messages can occur--onscreen and email 

notification.  A reminder regarding email messages, depending on your security settings you may need 
to add *@rsna.org in your trusted sites list.  System-generated messages will be sent from 
programs@rsna.org.   

 
 SYSTEM MESSAGE TYPE NOTIFICATION 

TYPE 
SYSTEM STATUS 

1 Presentation 
conversion complete 

Email and 
onscreen 
(occasionally 
reload page ) 

Unlocked.    
Your file has been successfully converted. Preview and 
complete.  If corrections are needed, delete old file, 
make corrections, and upload new file. Convert, preview, 
and complete. 

2 Invalid Presentation 
 

Email and 
onscreen 

Unlocked.    
Limits exceeded, conversion halted. Delete old file, make 
corrections to meet presentation limits, and upload new 
file. Convert, preview, and complete. 

3 Presentation Video 
needed  
 
 

Email  Unlocked.   
System has detected that linked media identified in the 
system-generated email is missing from the uploaded 
file. Delete old file, embed file(s) in the PowerPoint file 
using Optimize Media Compatibility, and reload modified 
.pptx file.  Convert, preview, and complete. 
 

4 Default Error 
Message* 

Email and 
onscreen  

LOCKED. Screen is grayed out while RSNA staff 
investigates. See below for more details. 

 
If a Default Error occurs, an email notification will be sent indicating an error occurred while converting 
your PowerPoint presentation. RSNA staff has been notified and are investigating the issue.  Typically, 
staff can resolve the issue without additional intervention from you. In this case, you will receive an 
email when the issue has been fixed and your presentation is converted correctly. If we do encounter a 
problem that requires your assistance (example, a password-protected file), RSNA staff will email you 
directly. Please do not upload a new PowerPoint or video file unless instructed to do so. 

 
Please note, if the conversion of your presentation was initiated before the deadline and a default error 
was encountered requiring staff intervention, your presentation meets the submission criteria and it is 
eligible for presentation. Staff will work with you to resolve the technical issue and afford you the 
opportunity to review the completed presentation in a timely manner.  
 

mailto:programs@rsna.org
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Step 2: Preview Presentation 
When the conversion process is complete, you will receive an email with a link directly to the Step 2:  Preview 
Presentation mode. Click or tap on the presentation to advance the slides, or use the numbered slide timeline 
below your main slide as follows:  

 
• Click on the previous/next buttons to advance the presentation slide by slide in the direction 

indicated. 
• Click within the slide to activate animations in that particular slide. 
 

When you have previewed your presentation in its entirety and are satisfied with your results, click the Back 
button and proceed to Step 3: Complete Presentation. 
 

A. Making Corrections:  If you discover errors in your presentation, use the Delete button to remove your 
presentation.  After the corrections have been made to your original PowerPoint, upload and convert 
the modified file. Upon receiving the email indicating that the conversion process is finished, preview 
your presentation once more, and complete the presentation. 

 
B. Technical Issues with Your PowerPoint? If you encounter problems during Step 2: Preview Presentation, 

please contact programs@rsna.org and provide the following: 
 

• presentation ID number 
• slide number(s)  
• for each slide number listed, provide a brief description of the issue 
• browser name and version (e.g. Chrome 84)  
• operating system name and version (e.g. Windows 10) 
• name and version of software you used to create your presentation (e.g. PowerPoint for 

Mac 2019) 
 
RSNA staff will compare the converted PowerPoint with your original file to determine if they can 
correct the problem, or if you need to submit a new file. 

 
Please note, there are some issues that RSNA staff will not be able to resolve if the following have been 
used:  

• Morph text animation  
• Zoom for PowerPoint 
• 3D Models 
• Ink Effects 
• 3rd party embedded plugins 
• non-standard fonts 
• extremely complicated animations 

 
 
 

mailto:programs@rsna.org


 
DPS Getting Started (8/2021) Page 6 of 7 
 

 

 
 
Step 3: Complete Presentation 
Click on Step 3: Complete Presentation to set a Welcome Message and respond to required questions.  Once you 
have marked your presentation as ‘completed’ no changes will be allowed. Only presentations that have clicked 
the Complete button and are free of promotional/commercial material, have patient identity protected, and 
consist of original work with no previous copyrighted material including images, media/cartoon content, will be 
displayed at the RSNA meeting.  

 
A. The Welcome Message will be displayed to meeting attendees when they use the discussion area of the 

presentation system during the RSNA annual meeting.  
 

B. Once you click on Step 3: Complete Presentation to finalize your presentation, it is locked for staff 
review and you will no longer have access to edit, delete, or download your presentation. Your 
presentation will be listed as Completed on the main Presentation Editor screen. Once your 
presentation has been finalized, it will be reviewed for technical and patient information compliance. It 
will then be transferred to the meeting site server. 

 
 
6. Helpful Tips 
 

A. Animated .gif files: Animated image (.gif) files are now supported in the DPS environment, in addition to 
other video formats such as .mp4; .avi; .mov; .mpeg. 

 
B. Aspect Ratio:  To check or change this setting in PowerPoint, click on the Design tab, then select Page 

Setup. Select On-screen show (4:3) or (16:9).  Ratio of 4:3 is recommended.  While the 16:9 setting can 
be used for your digital poster presentation, it is better suited for presentations assigned to meeting 
rooms using wide screen projection. 

 
C. Browser Preferences (in order): Google Chrome (recommended); Apple Safari; Mozilla Firefox; or 

Microsoft Edge. (least recommended) 
 

D. Click-activated Animations: Test your animation settings thoroughly before completing your 
presentation.  Sophisticated animations are not supported in the DPS environment, including the Morph 
text animation. While animations triggered by the user can be an effective presentation tool, user 
feedback suggests excessive use of user-initiated animations should be avoided. 
 

E. Completing Presentation: Please do NOT mark your presentation as “Final” in PowerPoint using the File 
-> Protect Presentation -> Mark as Final option. This will cause your presentation to error during 
conversion. 

 
F. Conversion Times:  Please allow 5 to 30 minutes, depending on file size and the number of videos 

incorporated into your presentation. Please plan accordingly--conversion times will be longer as more 
users start to upload closer to the deadline. 
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G. Filenames:  Please refrain from including accented or special characters in the file names of your 
uploaded files. Please choose a U.S. format for your keyboard when naming your files.  Reminder, if you 
have enabled password protection, it must be disabled before you upload your file to the DPS site. 

 
H. Fonts:  Basic fonts provided in PowerPoint are supported. For best results, use san-serif fonts such as 

Calibri, Tahoma and Verdana.  If you choose fonts other than those listed, please embed them in your 
Power Point by following the steps in the next section. You should change your font if you are not happy 
with the results of your test as they likely are not supported. 
 

I. Embedding Fonts:  
1. In PowerPoint 2010 or above, click the File tab, and then click Options in the left pane. 
2. In the PowerPoint Options dialog box, in the left pane, click Save. 
3. Under Preserve fidelity when sharing this presentation, select the Embed fonts in the file. 
4. Click OK. 
 

J. Interactive quiz formats:  The presentation system is designed to support linear presentations. Though 
not supported by RSNA, some nonlinear (interactive/hyperlinked) functionality may perform in the 
presentation environment. It is up to the individual author to design and test their presentation to 
determine if nonlinear functionality will provide a satisfactory presentation experience. 
 

K. Presentation Software: We recommend creating your presentation in PowerPoint for Windows. If you 
create your presentation using a different software (PowerPoint for Mac, Google Present or Keynote for 
Mac) and save it in .pptx format, please be aware that your presentation may not look the same when 
opened in PowerPoint for Windows.  Please remember to preview your presentation in the latest 
version of PowerPoint for Windows and correct any errors before uploading. 

 
L. Video Settings:  The conversion process that changes your PowerPoint file to the mobile-friendly format 

will automatically change video settings to auto-start and to loop. 
 

M. Viewing: To test how your presentation will be displayed on a mobile device, click on the link contained 
in your conversion confirmation email. If you are satisfied with your presentation, click the Edit button, 
then the button for Step 3: Complete Presentation. 

 
 
7.  Help and Support  
It is important to review and print the Help tab to assist you in preparing your presentation. Questions 
concerning the presentation system not covered in the materials provided can be addressed by the RSNA 
support team at programs@rsna.org; or phone 877-776-2227 (within the U.S.) or 630-590-7774 (outside the 
U.S.) during regular business hours, Monday-Friday, 8:30 am - 4:30 pm Central Time. 
 
Please always provide in your communications: your name; presentation number; presentation title. 
 
 
RSNA Program Services Department 
programs@rsna.org 
630-590-7774 (outside US)   
877-776-2227 (within US) 

mailto:programs@rsna.org

